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ABSTRACT 
The construction of the Drag Race circuit grandstand in Sidoarjo Regency is a public facility owned by the private 

sector which aims to accommodate the Drag community and Drag training. The background of this project is that there are many 
Drag interests in Sidoarjo Regency but do not have adequate facilities, it is planned to use steel and reinforced concrete 
structures including roof plates, floor plates, sloofs, beams, columns and bore pile foundations. With the planning and design of 
the drag race circuit facility building in Sidoarjo, it is hoped that it can become a forum for drag race fans who were previously 
in Sidoarjo and its surroundings. Based on earthquake calculations, the response spectrum graph from the results of analysis of 
soil data, ground acceleration parameter values from the rsa.ciptakarya.pu website. go.id. Category D was obtained with a value 
of SDs = 0.72 and SDI = 0.65, therefore the structure of the Special Moment Resisting Frame System (SRPMK) was planned. X 
Ø10-200mm, y direction reinforcement Ø10- 200mm., y direction reinforcement Ø12-200mm. Main beam 1 60cm x 40 cm with 
5D32 bearing reinforcement, 5D32 field reinforcement and Ø12-240mm shear reinforcement. Sloop 40cm x 30cm. Children 
beams 20cm x 30cm with 2D19 support reinforcement, 2D19 field reinforcement, and with concrete quality f'c 35 Mpa. 

Keyword: Grandstand planning, Drag Race, Dimensions and Structural Reinforcement. 

ABSTRAK 

Pembangunan tribun sirkuit Drag Race di Kabupaten Sidoarjo merupakan fasilitas umum milik swasta yang bertujuan 
untuk mewadahi komunitas Drag dan pelatihan Drag. Latar belakang dari proyek ini adalah banyaknya minat Drag di Kabupaten 
Sidoarjo namun tidak memiliki fasilitas yang memadai, direncanakan menggunakan struktur baja dan beton bertulang meliputi 
pelat atap, pelat lantai, sloof, balok, kolom dan pondasi Bore pile. Dengan adanya perencanaan dan perancangan bangunan 
fasilitas sirkuit drag race di Sidoarjo diharapkan dapat menjadi wadah bagi pengemar drag race yang tadinya di Sidoarjo dan 
sekitarnya.Bedasarkan perhitungan gempa grafik respons spectrum dari hasil Analisa data tanah nilai parameter percepatan tanah 
dari website rsa.ciptakarya.pu.go.id. didapatkan Kategori D dengan nilai SDs = 0,72 dan SDI = 0,65 maka dari itu direncanakan 
struktur Sistem Rangka Pemikul Momen Khusus (SRPMK).Hasil dari perhitungan ini berupa dimensi struktur beserta 
penulangannya didapatkan pelat atap didesain sebagai pelat dua arah dengan tulangan arah X Ø10-200mm, tulangan arah y Ø10- 
200mm., tulangan arah y Ø12-200mm. Balok Induk 1 60cm x 40 cm dengan tulangan   tumpuan 5D32, tulangan lapangan 5D32, 
dan tulangan geser Ø12-240mm. Sloof 40cm x 30cm. Balok Anak 20cm x 30cm dengan tulangan tumpuan 2D19, tulangan 
lapangan 2D19, dan Dengan mutu beton f’c 35 MPa.  

Kata kunci: Perencanaan tribun, Drag Race, Dimensi dan Penulangan Struktur 

1. PENDAHULUAN
Otomotif merupakan olahraga yang banyak diminati di seluruh dunia. Begitu juga dengan Indonesia. Olahraga
otomotif merupakan salah satu cabang yang sangat diminati oleh berbagai kalangan di Indonesia. Seiring dengan
bertambahnya minat masyarakat akan kegiatan-kegiatan yang berhubungan dengan otomotif, terutama balap motor
maupun mobil, maka dibutuhkan sarana yang memadai untuk melaksanakan event-event balap baik yang berskala
nasional, ataupun yang berskala internasional. Didukung dengan semakin majunya teknologi menimbulkan
persaingan diantara pembalap semakin menarik. Pembalap harus memiliki teknik dan ketrampilan yang
memumpuni, namun peningkatan sarana prasarana penunjang khususnya sarana fisik berupa sirkuit. Dengan adanya
tuntutan sarana penunjang berupa sirkuit yang membutuhkan lahan yang cukup luas dan strategis.

Berdasarkan hal tersebut, penulis akan merancang redesain yang mencakup fasilitas-fasilitas sirkuit berupa tribun 
utama, dan paddock area secara keseluruhan menjadi sebuah fasilitas sirkuit yang memenuhi standar-standar yang 
telah ditentukan sehingga sirkuit drag Sidoarjo ini dapat menjadi sirkuit yang menjadi kebanggaan Indonesia 
didalam dunia otomotif. menyangkut standarisasi dan regulasi race yang akan digelar di sirkuit tersebut, sejak dari 
perencanaan, pelaksanaan, dan pengawasan proyek sirkuit harus melibatkan induk-induk organisasi olahraga 
nasional dan internasional yang akan memanfaatkan keberadaannya. 
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Karena aspek-aspek diatas, dalam kontruksi tribun biasanya mengunakan jasa kontraktor spesialis baik dalam desain 
struktur maupun kontruksi dilapangan. Nantinya kontraktor spesialis inilah yang mendesain sesuai data-data 
perencanaan dan menganalisannya sehingga didapatkan spesifikasi properti-properti dan material yang digunakan 
dalam pembangunan tribun. Namun pada tender, penunjukan kontraktor spesialis ini sering dilakukan belakanggan 
dan kontrak untuk kontruksi atap tersebut belum pasti sehingga mereka biasanya tidak memberikan detail analisis 
yang diperlukan konsultan utama dalam menganalisa stuktur utama. Karena hal inilah konsultan utama mengalami 
kesulitan dalam menganalisa struktur tribun yang seharusnya dianalisa kontinu dengan struktur atapnya, yang 
mengakibatkan dimensi struktur hasil perhitungan tidak efisien. 

Atas dasar itulah, dalam skripsi ini penulis merencanakan bangunan tribun dengan rangka struktur baja beam. 
permodelan tribun dengan system yang menyatu antara struktur atap dan tribun. 

Rumusan Masalah 

Rumusan masalah yang dapat diambil berdasarkan latar belakang yang telah dijabarkan diatas, rumusan 
permasalahan yang dihadapi dalam perencanaan struktu tribun. 

1. Bagaimana analisis struktur tribun sirkuit berbahan baja beam. 

2. Bagaimana desain (perencanaan) strukture tribun sirkuit baja beam sesuai dengan SNI T-25-1991-03. 

3. Bagaimana Preliminary design rangka baja, kolom, balok. 

4. Bagaimana pembebanan struktur rangka baja, kolom, balok. 

5. Bagaimana menganalisa gaya-gaya yang bekerja 

Batasan Masalah 

Dalam melakukan perencanaan Struktur tribun mengunakan rangka baja beam di sirkuit drag race Sidoarjo, Desa 
Tambak Oso, Kecamatan Waru, Sidoarjo, Jawa Timur. Batasan masalah meliputi beberapa hal sebagai berikut: 

Perencanaan bangunan tribun mengunakan rangka struktur baja beam di sirkuit drag race Sidoarjo, Desa Tambak 
Oso, Kecamatan Waru, Sidoarjo Jawa Timur. 

1. Perancangan meliputi struktur bawah yaitu, pondasi dan struktur atas yaitu balok, kolom.   

2. Jenis tanah yang telah ditijau adalah tanah lunak (SE). 

3. Perhitungan pada bebanan dengan beban berfaktor yang meliputi beberapa beban yaitu : beban mati, 

beban hidup. 

4. Analisis struktur ditinjau dalam bentuk 3 dimensi menggunakan bantuan software sketchup.  

5. Perencanaan struktur Baja hanya pada tribun (balok, dan kolom) mengacu pada SNI 1729:2019. 

6. Perencanaan teknik structure tribun mangacu pada SNI 03 3647-1994 

Tujuan Penelitian 

Tujuan dari penelitian ini adalah: 

1. Penulis dapat merencanakan suatu struktur tribun yang aman terhadap beban rencaa yang bekerja sesuai 

dengan peraturan yang berlaku yaitu Standar Nasional Indonesia (SNI).  

2. Mendapat desain tribun yang diharapkan mampu menahan beban mati dan beban hidup. 

3. Merncanakan tribun balok, plat lantai, dan kolom baja 

4. Menentukan Beban-beban yang harus ditahan oleh struktur baja beam 

Manfaat Penelitian 

Manfaat yang diharapkan dari penyusunan tugas akhir ini adalah sebagai berikut: 

1. Perencanaan ini diharapkan dapat menjadi pengetahuaan baru bagi penulis dan dapat bermanfaat bagi 

pembaca pada umumnya. 

2. Mempelajari dan memahami perencanaan struktur tribun beton bertulang dan kontruksi rangka baja 
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beam. 

3. Dapat memenuhi persyaratan tugas akhir pada program Strata Satu (S-1) Program Studi Teknik Sipil 

Fakultas Teknik Universitas Tunas Pembangunan Surakarta. 

 

2. LANDASAN TEORI.  

Acuan Peraturan 

Peraturan yang digunakan sebagai acuan dalam perencanaan ini adalah : 

1. SNI Gempa Pedoman Perencanaan Ketahanan Gempa untuk Struktur  Bangunan Gedung (SNI-1726-2002) 

2. SNI Baja Tata Cara Perencanaan Struktur Baja untuk Bangunan Gedung (SNI 03-1729-2002) 

3. Pembebanan Pedoman Perencanaan Pembebanan untuk Rumah dan Gedung (SKBI 1.3.53.1987) 

 

Aspek Perencanaan 

Untuk ultimate limit state, kebutuhan utama dalam mendesain struktur bangunan adalah mampu dan mempunyai 
kekuatan yang cukup dan tetap stabil dari kemungkinan terburuk akibat gaya yang bekerja selama konstruksi dan 
masa layanan bangunan tersebut. 
Ini memerlukan suatu analisa gaya dan kekuatan yang akan terjadi pada elemen sebagau hasil kombinasi beban 
paling kritis, mencakup pembesaran momen (P-Delta efek). Suatu cadangan kekuatan yang cukup, menggunakan 
faktor pembebanan yang ditentukan, harus ditampilkan. Perhatian tertentu harus memperhatikan elemen kritis yang 
gagal membuktikan bencana besar dalam menginisiasikan keruntuhan progresif sebagian atau keseluruhan 
bangunan. Tambahan tegangan disebabkan oleh terkendalinya perbedaan pergerakan akibat creep, penyusutan atau 
temperatur harus diamsukkan. 
Penetapan tentang kekakuan yang cukup, terutama sekali kekakuan lateral adalah  pertimbangan utama dalam 
mendesain bangunan tinggi untuk berbagai alasan penting. Dalam hal ini menyangkut serviceability limit state, 
pertama : defleksi harus cukup terjaga pada tingkat bawah untuk mengijinkan fungsi komponen non-struktural 
seperti pintu dan elevator, kedua : struktur harus cukup kaku untuk mencegal pembesaran gerakan dinamis yang 
menyebabkan kegelisahan penghuni, sensitifitas peralatan 
Satu parameter sederhana yang mampu mengestimasi kekakuan lateral pada bangunan adalah indeks simpangan 
antar lantai (drift index) yang didefinisikan sebagai rasio defleksi maksimum puncak bangunan dengan tinggi total 
bangunan tersebut. Sebagai tambahan, nilai yang bersesuaian untuk bangunan satu tingkat, drift index memberikan 
suatu ukuran tentang deformasi berlebihan yang dilokalisir. Kontrol defleksi lateral sangat penting pada bangunan 
modern. Itu harus ditekankan bahwa sekalipun drift index dijaga dalam suatu batasan tertentu, seperti 1/500 , 
tidaklah perlu mengikuti bahwa kriteria kenyamanan dinamis akan memuaskan. 
Pertimbangan perencanaan diperlukan ketika memilih nilai drift index dan kekakuan yang cukup harus ditampilkan 
untuk memastikan bahwa defleksi tidak melebihi nilai dibawah kondisi beban ekstrim. Jika berlebihan, drift index 
pada struktur dapat dikurangi dengan merubah konfigurasi geometris untuk merubah tahanan beban lateral, 
penambahan kekakuan lentur elemen horisontal, menambah kekakuan dengan pengaku dinding atau elemen 
corewall dan stiffer connection. Dalam keadaan ekstrim dimungkinkan menambahkan peredam aktif maupun pasif. 
 

Faktor Kenyamanan 

Jika suatu struktur fleksibel tinggi didasarkan pada defleksi lateral atau torsional akibat fluktuasi beban angin, 
gerakan osilator dapat menyebabkan respon penghuni gedung, seperti kegelisahan dan kemuakan akut. Pergerakan 
itu mempunyai pengaruh fisiologis atau psikologis pada penghuni yang kemudian mengakibatkan suatu struktur bisa 
diterima atau menjadi sebaliknya, menjadi suatu yang tidak diinginkan bahkan menjadi bangunan yang sia-sia. 
Hingga kini tidak ada standar internasional yang bersifat universal untuk kriteria kenyamanan, walaupun mereka 
sudah membahasnya dan perencana harus mendasarkan kriteria desain pada suatu data penilaian yang diterbitkan. 
Umumnya disepakati bahwa percepatan adalah parameter utama dalam menentukan respon manusia terhadap 
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getaran tetapi faktor lain seperti periode, amplitudo, orientasi bentuk, akustik dan visual, dan bahkan pengalaman 
masa lalu dapat berpengaruh 

 

Material Konstruksi 

Penggunaan baja sebagai bahan struktur utama dimulai pada akhir abad kesembilan belas ketika metode pengolahan 
baja yang murah dikembangkan dengan skala yang luas. Baja merupakan bahan yang mempunyai sifat struktur yang 
baik. Baja mempunyai kekuatan yang tinggi dan sama kuat pada kekuatan tarik maupun tekan dan oleh karena itu 
baja adalah elemen struktur yang memiliki batasan sempurna yang akan menahan beban jenis tarik aksial, tekan 
aksial, dan lentur dengan fasilitas yang hampir sama. Berat jenis baja tinggi, tetapi perbandingan antara kekuatan 
terhadap beratnya juga tinggi sehingga komponen baja tersebut tidak terlalu berat jika dihubungkan dengan 
kapasitas muat bebannya, selama bentuk struktur yang digunakan menjamin bahwa bahan yang dipergunakan secara 
efisien. 
Pertimbangan lainnya adalah material baja banyak tersedia secara luas dan daya tahannya ( durability ) baik, 
khususnya bila di tambahkan proteksi terhadap karat akibat cuaca dengan cara pengecatan maupun pelapisan 
galvanize dan sandblasting, selain itu fabrikasi atau pekerjaan kontruksi yang sangat singkat. Sehingga total waktu 
kontruksi bisa berkurang yang akan berakibat pada penurunan biaya kontruksi. 
Baja dihasilkan dengan menghaluskan biji besi dan logam tua bersama-sama bahan tambahan pencampuran yang 
sesuai, Kokas (untuk karbon), oksigen dan bahan logam lain seperti tembaga, nikel, krom, mangan, fosfor, silicon, 
belerang, dan lain-lain. Untuk menghasilkan kekuatan, keliatan dan karakteristik terhadap ketahanan korosi karat 
yang diinginkan. 
Mutu baja terbagi dalam beberapa mutu yang berbeda, yang sering dipakai diantaranya JIS G 3101 – SS 400 ( setara 
ASTM A36 ) JIS G 3106 – SM 490 ( setara dengan ASTM A 572 ), HPS 70 ( High Performance Steel ). Yang 
membedakan dari ketiga mutu baja diatas adalah material properties, yield strength dan tensile strengthnya. Untuk 
tujuan perencanaan, tegangan leleh tarik adalah besaran yang di gunakan oleh spesifikasi, seperti AISC, sebagai 
variable sifat bahan untuk menetapkan tegangan ijin terhadap berbagai macam pembebanan. 
 

Deskripsi Elemen Struktur 

BALOK 
Balok merupakan elemen struktur penahan gaya lentur dan geser yang tehubung kaku dengan kolom-kolom pada 
ujung-ujungnya sehingga memiliki momen maksimum terdapat pada ujung-ujung balok tempat terjadinya sendi 
plastis saat terjadi gempa. 
Desain balok pada tugas akhir ini dibedakan berdasarkan besarnya beban yang bekerja secara vertikal terutama 
beban sendiri struktur, pelat serta beban hidup saat masa layan. Balok teridir dari balok utama dan balok anak. Balok 
utama adalah balok-balok yang ujung-ujungnya bertumpu langsung kepada kolom. Sedangkan balok anak adalah 
balok-balok yang ujung-ujungnya bertumpu pada balok utama yang arahnya sejajar arah Y global. Balok-nalok 
utama yang sejajar balok anak akan memiliki dimensi penampang lebih kecil dibandingkan balok-balok utama yang 
tegak lurus terhadapnya. Akibatnya, momen lentur yang terjadi pada balok utama yang tegak lurus balok anak 
tentunya akan lebih besar dibandingkan dengan balok utama yang sejajar balok anak. Selainitu, balok utama yang 
berada pada bidang perimeter akan menanggung beban vertikal lebih kecil dibandingkan balok-balok utama yang 
bukan pada bidang perimeter karena sebagian gaya-gaya vertikalnya akan disalurkan kepada bresing. 
Banyak hal yang dapat mengakibatkan mundurnya waktu penyelesaian suatu proyek. Beberapa penyebab yang 
paling sering terjadi antara lain: perubahan kondisi lapangan, perubahan desain atau spesifikasi, perubahan cuaca, 
ketidaktersediaan tenaga kerja, material, ataupun peralatan. Pada perencanaan kerja seringkali timbul masalah 
operasional yang menghambat aktivitas penyelesaian suatu proyek, seperti: kurangnya sumberdaya, alokasi sumber 
daya yang tidak tepat, keterlambatan pelaksanaan proyek dan masalah-masalah lainnya diluar jadwal dalam rencana 
kerja. 
Menurut Kraiem dan Dickmann (dalam Proboyo, 1999), penyebab- penyebab keterlambatan waktu pelaksanaan 
proyek dapat dikategorikan dalam 3 kelompok besar yakni:Keterlambatan yang layak mendapatkan ganti rugi 
(Compensable Delay), yakni keterlambatan yang disebabkan oleh tindakan, kelalaian atau kesalahan pemilik 
proyek. 
 
KOLOM 
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Kolom merupakan elemen struktur penahan gaya aksial dan lentur yang terhubung kaku dengan balok-balok di atas 
dan di bawahnya. Pada saat terjadi gempa, kolom-kolom menerima sebagian beban lateral yang sebelumnya telah 
didistribusikan lebih besar kepada elemen bresing 
Kolom-kolom luar direncanakan dengan sumbu kuat tegak lurus terhadap bidang bresingnya. Sedangkan untuk 
kolom-kolom dalam disejajarkan dalam satu arah saja agar mempermudah dalam hal analisis dan perhitungan serta 
mempermudah pada saat masa konstruksi. 
Mula-mula kolom direncanakan sama pada tiap lantai. Lalu dengan mengambil acuan kolom paling atas dedesain 
hingga memenuhi strength ratio antara 0.7-1.0 berikutnya menerus hingga ke bagian kolom dibawahnya sampai 
paling dasar. Kolom- kolom yang memiliki strength ratio dengan perbedaan yang kecil kemudian dikelompokkan 
menjadi satu jenis profil kolom hingga didapat beberapa jenis kolom tiap- tiap beberapa lantainya. Selainitu, kolom 
yang terdapat pada bidang bresing (kolom luar) yakni kolom portal bresing dan kolom sudut, serta kolom dalam 
juga dibedakan karena direncanakan memiliki kebutuhan tahanan yang berbeda. 
 

3. METODE PENELITIAN 

Tinjauan Umum 

Untuk membuat perencanaan struktur tribun diperlukan data-data sebagai bahan  cuan. Data -data tersebut dapat 
diklasifikasikan dalam dua jenis data, yaitu Objek Penelitian : 

• Data Primer 
• Data Sekunder 
• Data Perencanaan 

 

Data Primer 

Data Primer adalah data yang diperoleh dari lokasi rencana pembangunan maupun hasil survey yang dapat langsung 
dipergunakan sebagai sumber dalam perancangan struktur. Dari pengamatan dan survey di lapangan didapat data-
data sebagai berikut. 
 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

Gambar 1. Diagram Alir Metodologi Penelitian 

Data Sekunder 
Data sekunder adalah data yang berasal dari peratuaran-peraturan atau ketentuaan-ketentuan yang berlaku yang 
digunakan dalam perencanaan struktur tribun. Data sekunder merupakan data penunjang yang diperlukan dalam 
perencanaan struktur bangunan. Yang termasuk dalam klasifikasi data sekunder ini antara lain adalah literatur-
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literatur penunjang, grafik, tabel dan peta/denah yang berkaitan erat dengan proses perencanaan struktur Tribun 
Sirkuit Sidoarjo. 

4. ANALISIS DATA DAN PEMBAHASAN 

Pada tugas akhir ini, profil struktur rangka atap direncanakan menggunakan pipa baja circular hollow section. 
Ukuran yang dipilih adalah ukuran yang tersedia di pasar Indonesia. Ukuran pasar mengacu pada brosur Bakrie Pipe 
Industries. 
Rangka Busur Utama (SU) direncanakan menggunakan rangka batang ruang dengan dimensi tinggi vertikal 2,5 m 
dan lebar 2,5 m. 
 
 

 

 

 

 

 

 

Gambar 2. Bracing Busur Utama 

Pelat Lantai 
Untuk menentukan tebal pelat minimum baik untuk pelat satu arah maupun untuk pelat dua arah dipergunakan 
persyaratan yang telah tercantum di dalam SNI 2847:2013. Pelat dua arah adalah pelat yang memiliki perbandingan 
bentang yang panjang terhadap bentang yang lebih pendek tidak melebihi 2 (dua). 
Untuk memenuhi syarat lendutan, tebal minimum pelat satu arah harus dihitung sesuai dengan SNI 2847:2013 Pasal 
9 Tabel 9.5(a) seperti yang dipakai pada preliminary design pada balok. Sedangkan untuk pelat dua arah harus 
memenuhi persyaratan SNI 2847:2013 pasal 9.5.3.3. Syarat tebal minimum, h, harus memenuhi ketentuan sebagai 
berikut: 

 
 
 
 
 

Tabel 1 Beban mati PIUG 1983 

 
 

Data sekunder adalah data yang berasal dari peratuaran-peraturan atau ketentuaan-ketentuan yang berlaku yang 
digunakan dalam perencanaan struktur tribun. Data sekunder merupakan data penunjang yang diperlukan dalam 
perencanaan struktur bangunan. Yang termasuk dalam klasifikasi data sekunder ini antara lain adalah literatur-
literatur penunjang, grafik, tabel dan peta/denah yang berkaitan erat dengan proses perencanaan struktur Tribun 
Sirkuit Sidoarjo. 
 

Perencanaan Struktur Bawah 

Berdasarkan SNI 2847-2013 Pasal 18.6.2.1 bahwa lebar balok tidak boleh kurang dari 250mm dan perbandingan 
lebar terhadap tinggi kurang dari 0,3 

Tabel 2 Distribusi jenis kelamin responden 
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Perhitungan Dimensi Pelat 

Pelat yang akan direncanakan yaitu dengan ukuran 600cm x 500cm, dalam menentukan tebal minimum pelat, 
menggunakan ketentuan SNI 2847-2013 yaitu: 

Ln = 600 - 1
2
 (40+30) = 565 

Sn = 500 - 1
2
 (40+30) = 465 

β   = 𝐿𝐿𝐿𝐿
𝑆𝑆𝑆𝑆

 = 565
465

 = 1,21 < 2 .. Pelat Dua Arah 

tebal minimum berdasarkan SNI 2847-2013 menggunakan persamaan : 

Tebal Minimum Pelat = 𝐿𝐿𝐿𝐿
33

 = 600
33

 = 18,18cm 

Dipakai tebal pelat 20cm. 
 

Perhitungan Dimensi Pelat 

Hasil tabel di atas diperoleh hasil bahwa sebagian  besar responden  berjenis kelamin pria dengan jumlah 30 orang 
atau sebesar 90.9%, sedangkan responden paling sedikit berjenis kelamin wanita sebanyak 3 orang dengan 
presentase sebesar 9.1%. Berikut adalah distribusi jenis kelamin responden menggunakan gambar pie chart: 

Perhitungan Pembebanan Struktur Bawah 

Beban Mati Struktur Bawah 
Berat sendiri bahan bangunan berdasarkan SNI 1727-2013 adalah sebagai berikut : 
Dinding setengah bata  = 2,5 KN/𝑚𝑚2 
Beton bertulang   = 2,4 KN/𝑚𝑚2 
Spesi    = 2,1 KN/𝑚𝑚2 
Aspal    = 1,4 KN/𝑚𝑚2 
Plafond    = 1,1 KN/𝑚𝑚2 
MEP    = 2,5 KN/𝑚𝑚2 
 

Analisa Struktur Atap 

Di dalam analisa struktur bawah primer merupakan komponen utama, kekuatannya mempengaruhi perilaku dari 
gedung tersebut. Struktur ini berfungsi untuk menahan pembebanan yang berasal dari beban gravitasi dan beban 
lateral berupa beban gempa. Dalam analisa struktur bawah primer ini terdiri dari balok dan kolom. 

Menentukan Faktor Penggali 

Penentuan Besaran nilai yang sesaui dari factor pengali pada proses memasukan data respons spectrum demgan 
menggunakan persamaan sesuai dengan perturan SNI 1726 – 2013, yaitu sebagai berikut : 
Faktor Pengali = g x 1/R 
= 9,81 x 1/7  
= 1,401 
Keterangan :  
g = Gravitasi Bumi ( 9,81 ) 
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1 = Faktor keutamaan gedung ( 1 ) 
R = Faktor reduksi gempa ( 7 ) 
 

Penentuan Diafragma 

SNI Gempa 1726 – 2013 disimpulkan bahwa, analisis struktur harus mempertimbangkan kekakuan relative 
diafragma dan elemen vertical system penahan gempa. Select > All. Selanjutnya pilih Menu Assign > Joint > 
Contraints. Kemudian Define > Joint Contraints. 

 

Kombinasi Pembebanan 

1. 1,4 D 

2. 1,2 D + 1,6 L + 0,5 (Lr atau S atau R) 

3. 1,2 D + 1,6 ( Lr atau S atau S ) + ( L atau 0,5 W ) 

4. 1,2 D + 1,0 W + L + 0,5 ( Lr atau S atau R ) 

5. 01,2 D + 1,0 E + L + 0,2 S 

6. 0,9 D + 1,0 W 

7. 0,9 D + 1,0 E  

 

Menentukan Diafragma 

Pada SNI Gempa 1726 – 2013 disimpulkan bahwa, analisis struktur harus mempertimbangkan kekakuan relative 
diafragma dan elemen vertical system penahan gempa. Dalam hal ini pelat lantai dan atap beton dapat berfungsi 
menjadi diafragma yang menyumbangkan kekakuan gedung ketika beban lateral bekerja. Cara mengaplikasiakan 
lantai diafragma,pilih Select > All, selanjutnya pilih menu Assign > Joint > Constraints. Maka akan tampil kotak 
dialog Assign Join Constraints, klik Define Joint Costraints. 

Analisa Beban Atap 

Untuk melakukan analisi beban tetap yang sudah direncakan sebelumnya dapat dilakukan dengan cara pilih menu 
Analyze > Set Analysis Options, kemudian klk gambar Space Frame. Berikutnya untuk melakukan proses running 
dapat digunakan perintah Analyze > Run Analysis. Pastikan pada kolom action dalam keadaan Run kecuali Modal 
karena belum input beban gempa stank ekuivalen dan dinamik respons spektrum , apabila sudah maka kemudian 
klik Run Now. 

 

Analisa Beban Atap 

A.Dasar Perencanaan 

Mutu Beton fc’  = 35 MPa 

Mutu Baja  

BJTD  = 400 MPa 

BJTP  = 240 MPa 

Tebal Pelat = 12 cm  = 1,2 m 

Beban Hidup = 116 Kg/m2 

Beban Mati = 43,3 Kg/m2 
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Berat Berfaktor = 1,2 QDL + 1,6 QLL 

= 1,2 (43,3) + 1,6 (116) 

= 237,56 Kg/m2 

B.Perhitungan Momen Pelat Atap 

Lx  = 4 m 

Ly  = 4 m 

Ly/Lx = 4 / 4 =1 

Tabel 3 Momen Per meter Jalur Tengah Beban Terbagi Rata 

 
 
Untuk melakukan analisi beban tetap yang sudah direncakan sebelumnya dapat dilakukan dengan cara pilih menu 
Analyze > Set Analysis Options, kemudian klk gambar Space Frame. Berikutnya untuk melakukan proses running 
dapat digunakan perintah Analyze > Run Analysis. Pastikan pada kolom action dalam keadaan Run kecuali Modal 
karena belum input beban gempa stank ekuivalen dan dinamik respons spektrum , apabila sudah maka kemudian 
klik Run Now. 

 
 

5. PENUTUP 

KESIMPULAN 
Berdasarkan perancangan struktur yang dilakukan dalam penyusunan Tugas Akhir “Struktur Space Frame Sebagai 
Komponen Pembentuk Estetika Pada Perencanaan Tribun Sirkuit Drag Di Desa Tambak Oso Kecamatan Waru 
Kabupaten Sidoarjo Provinsi Jawa Timur” maka didapat beberapa point kesimpulan nya sebagai berikut :  
Perhitungan Struktur Pelat   
Pelat Lantai (Tebal 12 cm)  
Tulangan tumpuan arah X    = Ø12 – 240 mm 
Tulangan tumpuan arah Y    = Ø12 – 240 mm 
Tulangan lapangan arah X    = Ø12 – 240 mm 
Tulangan lapangan arah Y    = Ø12 – 240 mm 
Perhitungan Struktur Balok  
Balok B1 (600 x 300 mm)  
Tulangan tumpuan atas    = 5 D 32  
Tulangan tumpuan bawah    = 2 D 32  
Tulangan geser tumpuan    = Ø12 – 240  
Tulangan lapangan atas    = 2 D 32  
Tulangan lapangan bawah  = 5 D 32  
Tulangan geser lapangan  = Ø12 – 200  
Tulangan badan      = 2 D 12  
Balok Anak (400 x 200 mm)  
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Tulangan tumpuan atas    = 2 D 19  
Tulangan tumpuan bawah    = 2 D 19  
Tulangan geser tumpuan    = Ø10 – 110  
Tulangan lapangan atas    = 2 D 19 
 
Tulangan lapangan bawah    = 2 D 19  
Tulangan geser lapangan    = Ø10 – 110   
Sloof (400 x 300 mm)  
Tulangan tumpuan atas    = 4 D 28  
Tulangan tumpuan bawah    = 2 D 28  
Tulangan geser tumpuan    = Ø12 – 200 mm 
Tulangan lapangan atas    = 2 D 28  
Tulangan lapangan bawah   = 4 D 28  
Tulangan geser lapangan   = Ø 12 – 200 mm  
Tulang badan   = 2 D 22  
Perhitungan Struktur Kolom  
Kolom K1 (800 x 800 mm)  
Tulangan memanjang      = 12 D 32  
Tulangan geser      = Ø12 – 200 

Saran 

Beberapa saran yang dapat disampaikan berdasarkan hasil analisis dan pembahasan yang telah dilakukan adalah 
sebagai berikut :  

a. Dalam melakukan perancangan sebuah bangunan struktur diharapkan untuk menggunakan bantuan 
software yang tersedia seperti : SAP2000 V.22, Microsoft Word 2016, Microsoft Excel 2016, lain agar 
mudah untuk menggambar, menghitung, dan menganalisa struktur  dan juga menggunakan peraturan SNI 
yang masih berlaku.  

b. Perlu dilakukan analisis lebih lanjut mengenai pengaruh kondisi tanah yang berbeda untuk mengetahui 
perilaku struktur secara akurat.  

Dalam melakukan analisis perencanaan struktur menggunakan program SAP2000 v.22, hendaknya lebih teliti dalam 
memasukan data-data perhitungan 
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